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Word 2002: Expert

(OFFICE EXPERT)

Task Reference List

Description of task Exercise reference(s)

AutoCorrect entry, create

Choose Tools, AutoCorrect Options; key entry
in Replace box and in With box; click Add.

Summary of recommended procedure

3-D style, apply to objects
Click object to select. Click 3-D Style button
on Drawing toolbar and choose style. To

change settings, choose 3-D Settings and then
click buttons on 3-D Settings toolbar.
AutoShapes, add text to

Right-click shape and choose Add Text. Key text.

AutoShapes, align
Select shapes. Click Draw, Align or Distribute.
Choose one of the Align options.

AutoShapes, apply fill color to

Click shape to select it. Click Fill Color
button |¥] on Drawing toolbar and choose
color. To use fill effect, choose Fill Effects and
click tab (Gradient tab for one- or two-color
fills, Texture tab, Pattern tab, or Picture tab).

AutoShapes, change

Click shape. Click Draw, Change AutoShape.
Choose another AutoShape.

AutoShapes, change order of

Right-click shape and choose Order. Choose
one of the Send or Bring options.

AutoShapes, copy

Press and hold and drag shape.
AutoShapes, delete

Click shape to select it. Press [Delete].

AutoShapes, distribute

Select shapes. Click Draw, Align or Distribute.
Choose one of the Distribute options.

AutoShapes, draw
Click AutoShapes on Drawing toolbar. Choose
type of AutoShape. Click specific shape and
then draw.

AutoShapes, flip

Click shape to select it. Choose Draw, Rotate or
Flip. Choose option.
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AutoShapes, format

Double-click shape. Choose options in Format
AutoShape dialog box.

AutoShapes, group

Select shapes. Right-click selection and choose
Group.

AutoShapes, modify

Click shape to select it. Drag yellow diamond.

AutoShapes, move

Click shape to select it. Drag with four-headed
arrow pointer.

AutoShapes, resize

Click shape to select it. Drag one of the sizing
handles.

AutoShapes, rotate

Click shape to select it. Drag green rotate
handle.
AutoShapes, ungroup

Right-click grouped shapes and choose
Ungroup.

Axis, change font in

Double-click axis to open Format Axis dialog
box. Click Font tab. Select desired font options.
Click OK.

Balance columns

Position insertion point at end of last column.
Choose Insert, Break, Continuous to insert con-
tinuous section break.

Body text, show first line of

Select a heading. Click Show First Line Only
button [=] on Outlining toolbar.

Bookmarks, go to
Choose Edit, Go To or press [Ctr|+(G]. Under
Go to what, choose Bookmark. Under Enter
bookmark name, click down arrow to see list
of bookmarks in this document. Choose book-

mark. Click Go To.
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Chart types, combine ml

Bookmarks, insert

Choose Insert, Bookmark. Under Bookmark Select a data series in chart. Choose Chart,
name, key bookmark name. Do not key a space Chart Type, Standard Types tab. In Chart type
between words. Click Add button. list, select chart type for selected series. In

Chart sub-type list, select sub-type. Click OK.
Repeat for each data series that will have a
different chart type.

Check box form field, insert m

Position insertion point where you want field to
appear. Click Check Box Form Field button
on Forms toolbar.

Bookmarks, view
Choose Tools, Options, View tab. Select Book-
marks. Click OK.

Borders and shading, use

Choose Format, Borders and Shading. Click
appropriate tab and set options.

Browse the Web, download clip art
Open Insert Clip Art task pane. Click Clips Clip art, recolor m

Online to open Microsoft Office Design Gallery Right-click clip and choose Edit Picture. Click
Live. Using Browse or Search for text box, .
element of picture that you want to recolor. Use

whichever is available, key your search word .
’ &
and search for clip art. Click any clip to see Fill Color button [ to choose color.

larger preview and list of associated keywords. Clip art, rotate or flip m
Click preview of clip or down arrow below C . :

. e . Click clip. Click Draw, Rotate or Flip. Choose
clip to download clip. File is automatically Rotate or Flip option. If clip is not an in-line

downloaded into your Clip Organizer in folder . .
within new category called Downloaded Clips. graphic, drag its rotate handle to rotate.

Character formatting, clear Column chart, change color of columns in a data series R
Press [Ctrl]+ . Right-click column in the data series and

Character spacing, set choose Format Data Series from shortcut

Choose Format, Font, Character Spacing tab. ment. Whe‘n Format Data Series dialog box
. ... - appears, click Patterns tab. Select new color.

Choose scale, spacing, position, or kerning .

. Click OK.
options.
Chart gridlines, add m Column layout, create ml
Select chart. Choose Chart, Chart Options, Position insertion point. Choose Columns from
Gridlines tab. Select check box for each gridline Format menu. Choose options (set Apply to
you want to appear in chart. Click OK. box to This point forward or Whole document).
Chart title, move m Click OK.
Select title by clicking it. Drag it to new location. Column, resize by dragging
Chart titles, add m Point to column’s right-hand border. When
Select chart. Choose Chart, Chart Options, mouse pointer changes to two-headed arrow,
Titles tab. Click in Chart title box and type title. drag border to resize column. To see column’s
Type titles for each axis, if desired. Click OK. precise measurement on horizontal ruler,

press [Alt] as you drag border.

Chart type, apply a different type

gelecli chalr}; to bﬁ r{(l%clljﬁedion lgdicrosczlft Column, resize by using Table Properties dialog box
raph toolbar, clic art lype button down Click in table. Choose Table, Table Properties,

arrow and select desired chart type from Column tab. Click Previous Column or Next

List. To apply a chart sub-type, choose Chart, Column button to choose desired column.

Qhart Type, Standard Types tab. In Qhart. type Select Preferred width check box. Specify width
list, select chart type. In Chart sub-type list, .
for column. Click OK.

select sub-type. Click OK.
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Concordance file, use to create multiple index entries ml Document, create two versions of mI
Create new document that contains a two-col- Make change to original document. Choose

umn table. In first column, key each word (in a Versions from File menu. Click Save Now

separate cell) that you want to include in index. button and key a comment. Click OK.

In second column, key words as they should Document, protect from revisions ml
appear in index. Save and close document. In Choose Protect Document from Tools menu.
d9cument to be 1pdexed, open Index and Tables Choose Tracked Changes. Click OK.

dialog box and click AutoMark. Select concor- — —— -

dance file and click Open. Documents, distribute for revision via e-mail m

m Choose Tools, Letters and Mailings, Mail Merge
Wizard. Mail Merge Wizard opens. Under
Select document type, choose E-mail mes-
sages. Click Next: Starting Document. Use
current document and click Next: Select recipi-
ents. Click Browse to locate existing list. Click

Cross-reference, create

Select text to use as main index entry. Open
Mark Index Entry dialog box. Click Cross-
reference option. In Cross-reference text box,
type text that will appear in index as cross-

reference. Click Mark. Open. Click OK when Mail Merge dialog box
Custom menu, add commands to m appears. Click Next: Write your e-mail mes-
Right-click any menu or toolbar and choose sage. Key message. Click Next: Preview

Customize. Click Commands tab. From Save your e-mail message. Click Next: Complete

in drop-down list, choose file to save menu in. the merge. Save document. Click Electronic

Under Categories, click Format or other listing. Mail to merge to E-mail. Merge to E-mail

On menu bar, click menu you want to custom- dialog box opens. In To text box, make sure

ize. Drag Customize dialog box out of the way Email_Address is selected. In Subject line text

to see menu. Under Commands, scroll down box, key subject. In Mail format text box, choose
and click and drag command from dialog box Attachment. Click OK. Microsoft Outlook will

to menu. launch and send your messages.

Custom menu, remove new commands from ml Drawing canvas, expand m
Right-click any menu or toolbar and choose Click Expand button [E] on Drawing Canvas
Customize. Open menu on menu bar and click toolbar.

and drag command off of menu. Drawing canvas, fit m
Data series, plot against different axis 8-7 Click Fit button [&£] on Drawing Canvas toolbar.
Right-click data series and choose Format Data Drawing canvas, scale drawing on

Series from shortcut menu to open Format Click Scale Drawing button [] on Drawing

Data Series dialog box. Click Axis tab. Select Canvas toolbar.

appropriate axis. Click OK.

Drawing canvas, use text wrapping on

Document changes, create bookmark to locate Click Text Wrapping [ button on Drawing

Choose Bookmark from Insert menu. Key book- canvas toolbar and choose wrapping option.
mark name in Bookmark name text box. Click
Add to save bookmark.

Drawing toolbar, view
m Choose View, Toolbars and click Drawing.

D t Map, igate i . b .
ocument 1iap, navigdie in Drop-down list form field, insert

Position insertion point where you want field to
appear. Click Drop-Down Form Field button

In Document Map pane, click heading to jump
to that section of document.

Document Map, open and close m on Forms toolbar. Click Form Field Options
Choose View, Document Map to open Docu- button &1 to open Drop-Down Form Field
ment Map pane. Choose View, Document Map Options dialog box. In Drop-down item text
again to close pane. (Standard toolbar also box, key items to appear in drop-down list.

contains a button for Document Map.) Press or click Add button.
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Endnote, convert to footnote

Select endnote in pane or in Print Layout
view. Right-click endnote and choose Convert

to Footnote.

Insert page break at end of document. Switch
to Normal view. Display endnote pane by
choosing View, Footnotes, View endnote area.
Choose Endnote Separator from drop-down
list in pane. Delete separator, replace with
heading such as “NOTES,” and add space
before and after heading.

Endnotes, place on separate page

Place insertion point where chart will appear
in Word file. Open Excel file and select chart.
Choose Edit, Copy to copy chart to Clipboard.
In the Word file, choose Edit, Paste Special.

In Paste Special dialog box, select Paste option
and select Microsoft Excel Chart Object. Click
OK. Click Paste Options button @ drop-down
arrow and click Picture of Chart (smaller file
size).

Excel chart, embed in Word document

Excel chart, link to Word document m

Place insertion point where chart will appear
in Word file. Open Excel file and select chart.
Choose Edit, Copy to copy chart to Clipboard.
In the Word file, choose Edit, Paste Special.

In Paste Special dialog box, select Paste link
option and select Microsoft Excel Chart Object.
Click OK. Click Paste Options button drop-
down arrow and click Link to Excel Chart.

Excel data, import into Word chart ml

Double-click chart in Word document to acti-
vate Microsoft Graph tools. Click first cell of
datasheet. Click Import File button [#] and
select worksheet file to import. In Import File
Options dialog box, specify worksheet or range

to import and set other options. Click OK.

In Word document, place insertion point where
you want table to appear. Switch to Excel docu-
ment, select cells whose data will appear in the
table, and click Copy button [B3]. Switch back to
Word document and choose Edit, Paste Special
to open Paste Special dialog box. Choose Micro-
soft Excel Worksheet Object from list. Select
Paste option. Click OK.

Existing Excel worksheet, embed in document

Task Reference List

Existing Excel worksheet, link to document

In Word document, place insertion point where
you want table to appear. Switch to Excel docu-
ment, select cells whose data will appear in the
table, and click Copy button [B3]. Switch back to
Word document and choose Edit, Paste Special
to open Paste Special dialog box. Choose Micro-
soft Excel Worksheet Object from list. Select
Paste link option. Click OK.

Field code view options, set

Open file. Choose Tools, Options, View. Click to
select Field codes. Click OK.

Field codes, display and hide 7-22

Press [Alt+([F9) to display all field codes in docu-
ment. Press [Alt]+[F9) again to hide codes.

Field properties, change
Double-click to the left of field. Choose Insert,
Field. In Field properties section of dialog box,
choose field format.

Fields, apply multiple options to
Double-click to the left of field. Choose Insert,
Field. In Field properties section of dialog box,
choose field format. Click Field Codes. Click
Options and choose appropriate option from
list. Click Add to Field button. Click OK twice.

Fields, insert
Choose Insert, Field. Under Categories, choose
field category. Under Field names, choose field
name.

Fields, update 37

Right-click field and choose Update Field from
shortcut menu. Or click field and press [F9).

Fields, view and edit
Right-click field and choose Toggle Field Codes
from shortcut menu. Edit field codes with
appropriate syntax.

Find and replace formatting or styles
Choose Replace from Edit menu. Click in Find
what box and clear text. Click Format to choose

formatting or style. Do the same in Replace
with box. Click Find Next. Click Replace.
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Find and replace special characters m| Form field shading, turn on and off

Choose Replace from Edit menu. Enter text or Click Form Field Shading button [ to turn

special character in Find what box (use Special on/off shading.

button to chogse a char.actelj). Do the same Form field, add Help text to m
in Replace with box. Click Find Next. Click Click within field or select it. Click Form Field
Replace. Options button [E7] on Forms toolbar. Text Form
Footnote, convert to endnote 9-7 Field Options dialog box opens. Click Add Help
Select footnote in pane or in Print Layout Text button to open Form Field Help Text

view. Right-click footnote and choose Convert dialog box. Click Status Bar tab, if it is not

to Endnote. active. In text box under Type your own, key
Footnote/endnote, add m help text. Click OK twice.

Position insertion point. Press [Alt]+(Ctrl] + [F) Form field, choose Number option for ml
and key footnote text, or choose Insert, Refer- Click within field or select it. Click Form Field
ence, Footnote. Options button | on Forms toolbar. Open
Footnote/endnote, change number format for m ngne]bderro I%::ﬁ;%ij;i;iihﬁ;)f Z:dugk())izeopen

In pane or in Print Layout view, right-click foot- format. Under Field settings, make sure Fill-in

note or endnote and choose Note options from enabled option is checked. Click OK.

shortcut menu. Open Number format drop-

. Form, create a document based on
down list and choose format. !

ml Right-click Windows Start button and

choose Explore from shortcut menu. In Folders

Footnote/endnote, change placement of

In pane or in Print Layout view, right-.click list, navigate to folder containing the form.
footnote/endnote and choose Note options Double-click file, or right-click file and choose
from shortcut menu. Choose option in dialog New from shortcut menu.

box under Location.

Form, edit

Click Open button [&]. Choose Document Tem-
plates from Files of type drop-down list. Navi-
gate to folder containing form. Choose form
template and then click Open button. Unlock
form and make changes. Resave template or
Save As to assign a different name.

Footnote/endnote, copy

Copy reference mark in document. Paste to
new location.

Footnote/endnote, delete
Select reference mark in document. Delete it.

Footnote/endnote, edit or format Form, enter dafa in

In pane or in Print Layout view, select Click in a field. Key data or choose from a

footnote/endnote text. Edit or apply paragraph/ drop-down list. Press {6 move to next field.
character formatting.

Form, insert table in
Use Draw Table button |_Z| or Insert Table

Footnote/endnote, move

Cut reference mark in document. Paste to new button @ to create table in the form.
location.

. Form, protect 4-7
Footnote/endnote, view KR | oo Tools, Protect Document; in Protect
To see footnote/endnote text, point to reference Document dialog box, click Forms option and
mark in document and read ScreenTip. Or click OK. Or click the Protect Form button
change to Print Layout view or Print Preview. on the Forms toolbar.
Footnote/endnote, view in pane ml Form, save m
In Normal view, choose View, Footnotes to Choose File, Save As. A folder named Tem-
open footnotes pane. To see endnotes, open plates should appear in Save in box. Save your

drop-down list in pane and choose Endnotes. form as document template with new name.
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Heading, collapse m Hyperlink, insert bookmark m
Select heading in outline. Either click Collapse Create bookmark. Select word or phrase to use
button [=] on Outlining toolbar or double-click as hyperlink. Click Insert Hyperlink button
selection symbol 7 in front of heading. or press [Ctrl]+(K]. Under Link to, click Place in
Heading, demote 10-1, 10-7 This Document button. Under Bookmarks, click

kmark . Click OK.
Collapse document to show desired heading bookmark name. Click O

levels. Click heading’s selection Syl’l’lbOl to select Hyper“nk, insert Using Copy and Paste as Hyperhnk m
heading and all its subtext. Click Demote Copy text to become a hyperlink. Position

button [#] on Outlining toolbar. insertion point where you want hyperlink.

Heading, demote to body text 10-1, 10-7 From Edit menu, choose Paste as Hyperlink.

Select heading in outline. Click Demote to H link_insert head
Body Text button [#] on Outlining toolbar. yperink, insert nedding m

Style heading. Select word or phrase to use as
hyperlink. Click Insert Hyperlink button [¥&| or

Heading, expand

Select heading in outline. Click Expand press [Ctrl]+[K]|. Under Link to, click Place in

button [E on Outlining toolbar or double-click This Document button. Under Headings, click

selection symbol = in front of heading. heading name. Click OK.

Heading, promote 10-1, 10-7 Index entry, create m

Collapse document to show desired heading Select text to be used for main index entry.

levels. Click heading’s selection symbol to select Press [Alf)+[Shift) + [X] to open Mark Index Entry

heading and all its subtext. Click Promote dialog box. Click Mark.

button [#] on Outlining toolbar.

Headings, show multiple levels m Index entry, use range of pages n m
. Select all text to be covered by index entry,

Click Show Level button drop-down Create bookmark for selected text. Place inser-

arrow on Outlining toolbar. Select ’

tion point at end of bookmarked text. Open
Mark Index Entry dialog box. Click in Main
entry box and key main index entry. Click Page
range and select desired bookmark from Book-
mark list. Click Mark.

lowest heading level you want to appear in out-
line. Word hides all headings and body text
below the level you select.

HTML format, round-trip document from

Open HTML document. Choose Save As from ind b m
File menu. Open Save as type drop-down list X Sl EERIE
and choose Word Document. Click Save. Select text to be used for main index entry.

Press [[Alt)+ +[X] to open Mark Index Entry
dialog box. Click Subentry text box and key text
to be used as subentry. Click Mark.

Index, add to master document m

Place insertion point at end of master docu-
ment, but not within a subdocument. Choose

HTML, convert document to 14-7
Open file. Choose File, Save as Web Page.

Hyperlink to a Web site, create

Key Web site address. Word automatically cre-
ates hyperlink.

Hyperlink to another document, create m Insert, Reference, Index and Tables, Index tab.
Select word or phrase to use as hyperlink. Click Select desired options for your index. Click OK.
Insert Hyperlink button [¥&) or press (Ctrl+ (K] -

In Insert Hyperlink dialog box, under Link to, Index, compile and format m
click Existing File or Web Page. Click Current Place insertion point on blank line at end

Folder if it is not active. In Look in text box, of document. Open Index and Tables dialog

locate and click file to link to. The filename box. Click Index tab. Select desired formatting
appears in Address text box. Click OK. options. Click OK.
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Index, edit and update List style, create ml

In document, make changes to one or more Display Styles and Formatting task pane (Format,
index entry fields. Right-click index and choose Styles and Formatting). Click New Style, choose
Update Field from shortcut menu, or press [F9). List as style type, and choose options. To create a

ml bulleted list, click Bullets button |i=| and choose

Lesiils, clielige ol oplions iy symbol character for each list level.

Select legend. Choose Format, Selected Legend -
to open Format Legend dialog box. Click List, sort
Font tab. Select font options for legend’s text. Select list. Choose Table, Sort to open Sort Text
Click OK. dialog box. (If you want Word to recognize

each word as a separate field, click Options to
Legend, remove borders from m open Sort Options dialog box. Under Separate
Select legend. Choose Format, Selected Legend fields at, specify the character that separates
to open Format Legend dialog box. Click Pat- words, such as a blank space. Click OK.) In
terns tab. Under Border, click None. Click OK. Sort by list, choose word or field on which to
Legend, reposition in a chart m sort. In Typg list, choose TeXt' Click Ascending

or Descending option. Click OK.
Select legend. Choose Format, Selected Legend -
to open Format Legend dialog box. Click Place- Macro, assign keyboard shortcut to m
ment tab. Select position for legend. Click OK. Choose Tools, Customize. Click Keyboard button.
Line chart, change color of markers in data serie gﬁl j Oe Sr eglvla;i?:gel\s/[' aiirzﬂrzoyggitgﬁlglf ai::tﬁlini(i
Right-click line in data series and then choose selected from Save changes in list box. Under
Format Data Series from shortcut menu. When Macros, choose macro name. In Press new
Format Data Series dialog box appears, click shortcut key box, press keyboard combination.
Patterns tab. Under Marker, select new fore- Click Assign. Click Close. Click Close again.
ground and/or background color. Click OK. T m
Line chart, change color of lines in data series & Open Macros dialog box. Select macro to
Right-click line in data series and then choose be copied. Click Edit button. Select all text
Format Data Series from shortcut menu. When in macro. Click Copy button [E2| on Visual
Format Data Series dialog box appears, click Basic Standard toolbar. Go to bottom of code
Patterns tab. Under Area, select a new color. window and position insertion point on blank
Click OK. line below last macro. Click Paste button || on

ml Visual Basic Standard toolbar.

Click Line button [\ | on Drawing toolbar. Draw Magro, create Autolextentry to use with ' m
line in drawing canvas. To draw a straight line, Open template file. Create AutoText entries.

hold [Shift] as you draw. Resave template file or save it with new name.

Link text boxes m Macro, delete m

Open Macros dialog box. Select macro to
be deleted. Click Delete button. Click Yes.
Click Close.

Macro, edit 6-7

Choose Tools, Macro, Macros or press [Ali)+[F8].
In Macros in text box, choose template contain-

Line, draw

Draw text box. Insert text. Draw second text
box. Click in first text box. Click Create Text
Box Link button [#] on Text Box toolbar. Click
in second text box to flow text.

Link, edit to make documents portable

Press [Alt|+[F9] to display field codes. Find code ing macro. Choose macro from list above and
for hnlfed wor.ksheet. Edlt 1t to remoye all click Edit. In Visual Basic Editor window, make
the file’s path information. Leave file’s name changes to macro code. Click Save button [,
intact in field code. Press [Alt}+([F9) again to hide Then choose File, Close and Return to Micro-

field codes. soft Word, or press [Alt]+(Q).
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Macro, prepare to record ml
Choose Tools, Macro, Record New Macro. In

Macro name text box, key macro name. Under
Store macro in, choose Documents Based On.
In Description box, edit text to indicate that you
recorded macro. Press to start new line
and then key a description of what the macro
does. Click Keyboard button. With insertion
point in Press new shortcut key text box, press
a keyboard shortcut (for example, [Alt]+[1)).
Click Assign button. Click Close.

Macro, record

Using recording pointer, choose commands
that you want macro to perform. Click Stop
Recording button [m].

Macro, rename

With Visual Basic window open, select macro
name inside quotation marks and key new
name. Click Save button [&.

Macro, run
Choose Tools, Macro, Macros. Make sure cor-
rect template is selected in Macros in list box.
Select macro. Click Run.

Macro, set security

Choose Tools, Macro, Security. Display Security
Level tab. Choose security level. Click OK.

Macro, use letter template macros to create letter
Start new document based on template. Click

Enable Macros. Run macros. Save template as
Macros, copy

a letter.

| 610
Open template file. Press [Alt|+[F8] to open
Macros dialog box. Click Organizer button. In
Organizer dialog box, click Macro Project ltems
tab. On right side of dialog box, click Close
File. Click Open File on right side of dialog
box and navigate to folder containing file with
macros. Click Open. Make sure NewMacros is
selected in list on right side, and then click
Copy button to copy all macros in NewMacros
module to list on left side. The left and right
side might be reversed depending on what file
you are copying to. Click Close.
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Mail Merge, complete merge ml
In Mail Merge wizard task pane, click Next:
Complete the merge, and click Print to merge
to printer or click Edit individual letters to
merge to new document. Or click Merge to New
Document button [ on Mail Merge toolbar.

In Mail Merge wizard task pane, click Next:
Select Recipients. Choose Type a new list.
Click Create (fields can be added, deleted, and
renamed). Key data for records. Click New
Entry after each new record entered.

Mail Merge, create data source

Mail Merge, create labels m

Open new document. Choose Tools, Letters and
Mailings, Mail Merge Wizard. Choose Labels

as document type. Choose starting document
and label options (type and size). Choose

data source. Arrange labels by inserting merge
fields. Click Update all labels button. Preview

and complete the merge.

Mail Merge, create main document m
Choose Tools, Letters and Mailings, Mail Merge
Wizard; choose document type; click Next:

Starting document; select starting document.

Or display Mail Merge toolbar and click Main

document setup button [[&].

Mail Merge, edit main document m
Open document. Edit text as needed. Use Insert
Merge Fields button |[E] on Mail Merge toolbar

to insert new fields. Use View Merge Data

button [§2] and Next Record button [»] to pre-

view merged records.

Mail Merge, filter data source ml
Open data source file. Use Mail Merge Recipi-
ents button |&] to open Mail Merge Recipients
dialog box. Click down arrow next to a column
heading and choose records you want to filter.

Mail Merge, insert merge fields

| 54
In Mail Merge wizard task pane, click Next:
Write your letter; choose Address Block, Greet-
ing Line, or More items. Or click Insert Merge
Fields button |El| on Mail Merge toolbar.
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Mail Merge, preview merged data ml
In Mail Merge wizard task pane, click Next:

Preview your letters and click double-arrows to
preview each record. Or click View Merge Data

button [%] on Mail Merge toolbar.

Mail Merge, sort data source ml
Open data source file. Use Mail Merge Recipi-
ents button [E] to open Mail Merge Recipients
dialog box. Click column name heading to
sort list. Click down arrow next to a column
heading and choose (Advanced...). Click Sort
Records tab and in Then by drop-down list
choose second sort option.

Mail Merge, use Excel data source
Click Open Data Source button [@]. Locate

Excel file and open it. Use Mail Merge Recipi-
ents button |&/] to view records. Click Merge to

New Document button [,
Mail Merge, use Outlook data source m

Choose Tools, Letters and Mailings, Mail Merge
Wizard. Click Select from Outlook contacts.
Click Choose Contacts Folder. Click OK to
accept Outlook as Profile Name. Click OK to
choose Contacts Personal Folders. Click OK to
choose recipients from Outlook. Use Merge to
New Document button [ to merge records. If
Invalid Fields dialog box appears, replace fields
with fields from Outlook data source.

Mail Merge, use Word data source

Click Open Data Source button [@]. Locate
Word file and open it. Use Mail Merge Recipi-
ents button |&/] to view records. Click Merge to

New Document button [,

Master document, lock

Place insertion point in master document, but
not in a subdocument. For example, click
within section break before first subdocument
to place insertion point there. Click Lock Docu-

ment button [&.

Merge documents m
Choose Tools, Compare and Merge Documents.

In Compare and Merge Documents dialog box,
locate another revision of same file. Click Merge
down arrow and choose Merge into current doc-
ument. Word merges new file into currently
open file and displays revision marks identifying
changes between revised file and original file.

Task Reference List

Select first table you want to nest (and its cap-
tion). Drag it into an empty cell of parent table.

Nested tables, create multiple

Repeat for any other tables to be nested.

New Excel worksheet, embed in document
In Word document, place insertion point where
you want Excel worksheet to appear. Click
Insert Microsoft Excel Worksheet button [&.
When grid appears below button, drag to set
number of rows and columns for sheet. When
you release mouse button, worksheet appears
in document and Excel tools are added to
Word’s menu bar and toolbars.

Click in cell and key data. Use mouse or arrow
keys to move insertion point to another cell.
Click outside worksheet to turn off Excel tools.
Double-click worksheet to reactivate Excel
tools.

New Excel worksheet, enter data and navigate

Outline view, switch to

Click Outline View button |:Z| on horizontal
scroll bar.

Outline, copy and paste text in

106
Collapse document to show desired heading
levels. Click heading’s selection symbol to select
heading and all its subtext. Choose Edit, Copy
or click the Copy button |E3 to copy selected
text to Clipboard. Place insertion point where

the copy will go. Choose Edit, Paste or click the
Paste button 2| to insert the copied text.

Outline, delete text in m
Collapse document to show desired heading

levels. Click heading’s selection symbol to select

heading and all its subtext. Press [Delete].
Outline, move text by dragging m
Collapse document to show desired heading
levels. Click heading’s selection symbol to select
heading and all its subtext. Move selected text
to new location by clicking Move Up button [#]
or Move Down button [#] on Outlining toolbar.
Or you can move selected text by pointing

to its selection symbol; when mouse pointer
changes to four-headed arrow, drag text to its
new location.
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Outline, navigate in

Click Select Browse Object button [@]. Click
Browse by Heading button [£=]. Click Next
Heading button |§| to jump to next heading in
outline, or click Previous Heading button [£] to

jump to previous heading in outline.
Oval, draw m

Click Oval button [&] on Drawing toolbar. Draw
oval in drawing canvas. Hold as you draw
to create a circle.

Paragraph formatting, clear

Press [Ctr]+(QJ.

Paragraphs, sort 7-20
Select paragraphs to sort. Choose Table, Sort.

In Sort Text dialog box, under Sort by, choose
Paragraphs. In Type drop-down list, choose

Text. Click Ascending or Descending option.

Click OK.

Photographs, insert

Click Insert Clip Art button |[£] on Drawing
toolbar. In Search text box, enter keyword.
Open Results should be drop-down list, select
Photographs, and clear all other check boxes.
Click Search. Click thumbnail to insert.

Photographs, resize 1-17
Double-click photograph. Use Size tab to

specify size.

Plot area, change color of 3-8

Right-click plot area and then choose Format
Plot Area from shortcut menu. When Format
Plot Area dialog box appears, click Patterns
tab. Select new color. Click OK.

Position objects

Double-click object. Click Layout tab. Click
Advanced. Click Picture Position tab. Under
Horizontal, choose alignment type and what
object is relative to. Under Vertical, do the
same. Click OK twice.

Pull quote, create
Select text. Click Text Box button [£] on Draw-

ing toolbar. Format text box as desired.

Rectangle, draw m
Click Rectangle button [ on Drawing toolbar.
Draw rectangle in drawing canvas. Hold [Shift

as you draw to create a square.
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Row, resize by dragging

Point to row’s bottom border. When mouse

pointer changes to double-headed arrow, drag
border to resize row. To see row’s precise mea-
surement on vertical ruler, press as you
drag border.

Row, resize by using Table Properties dialog box AV
Click in table. Choose Table, Table Properties

to open Table Properties dialog box. Click Row
tab. Click Previous Row or Next Row button to
choose desired row. Select Specify height check

box. Specify a height for the row. Click OK.

Rows, keep together at page break 713
Select first of two rows you want to keep
together. Choose Format, Paragraph, Line and
Page Breaks tab. Select Keep with next check

box. Click OK.

Secondary axis, add 8-7
Select chart. Choose Chart, Chart Options to
open Chart Options dialog box. Click Axes tab.
Select check box for each secondary axis you

want to add to chart. Click OK.

Shadow, apply to objects 17
Click object to select. Click Shadow Style

button [B] on Drawing toolbar. Choose style. To
change settings, choose Shadow Settings; then

click buttons on Shadow Settings toolbar.

Starting page number, change

In header or footer pane, click Format Page
Number button . Change option under Page
numbering.

Style, create

Display Styles and Formatting task pane
(Format, Styles and Formatting). Click New
Style. Choose options (including style type—
paragraph, character, list, or table). Click OK.

Styles, modify 27
Right-click style name in Styles and Formatting

task pane and choose Modify. Choose options.
Click OK.

Subdocument, create from existing document
Switch to Outline view. Show desired heading
levels. Select heading and its subtext. Click
Create Subdocument button || on Outlining
toolbar.
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Subdocument, create from headings in Outline View m

Switch to Outline view. Create heading. Select
it. Click Create Subdocument button |E| on
Outlining toolbar.

Subdocument, insert into master document

Place insertion point where you want new sub-
document to appear in master document. Click
Insert subdocument button [2¥. In Insert Sub-
document dialog box, select document to be
inserted. Click Open.

Subdocument, lock
Place insertion point in subdocument. Click

Lock Document button [&.

Subdocument, move

Expand one or more subdocuments so their
section breaks are visible. Click subdocument
symbol B} next to subdocument you want to
move. Drag subdocument symbol up or down;
a gray horizontal line appears to show subdoc-
ument’s location. When line appears between
desired subdocuments’ section breaks, drop it.

Subdocument, open in separate window m

Do one of the following: (A) If subdocument’s
heading is visible, double-click subdocument
symbol Et for desired subdocument. (B) If
subdocument is displayed as a hyperlink, press
Ctrl] and click hyperlink.

Subdocument, remove
Select subdocument you want to remove from
master document. Click Remove Subdocument
button [8)]. If you want to delete former subdoc-
ument’s text from master document, leave it
selected and press .

Subdocument, split 12-7
Position insertion point where you want to
split subdocument. Click Split Subdocument

button [B]

Subdocuments, collapse
In master document, click Collapse Subdocu-

ments button [F.

Subdocuments, merge
Select subdocuments you want to merge. Click

Table form, enter data in
Navigate to fields by using [Tab). Enter data.

Merge Subdocument button [B]
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Table of contents, add to master document ml
Place insertion point at top of master docu-

ment, but not within a subdocument. Choose
Insert, Reference, Index and Tables, Table of
Contents tab. Select desired options for your

table of contents. Click OK.

Table of contents, create

Make sure Heading styles are applied to all
headings in document. Place insertion point
where table of contents should appear. Open
Index and Tables dialog box. Click Table of
Contents tab. Click OK.

Table of contents, edit and update m
Make changes to headings or other text in

document that might affect page numbering.
Click next to table of contents (in right or left
margin) and press [F9). Select Update entire
table option. Click OK.

Place insertion point in table of contents. Open
Index and Tables dialog box. Click Table of
Contents tab. Select formatting option from
Formats list box. Select leader style from Tab
leader list. Click OK twice to apply changes to
table.

Table of contents, format

Table style, create 79
Click in table. Display Styles and Formatting
task pane. Click Show drop-down arrow and
choose All styles. Click New Style to open

New Style dialog box. Specify name for new
style in Name box. Click Style type drop-down
arrow and choose Table. Click Apply formatting
to drop-down arrow and select a part of the
table (or entire table) to format. Set formatting
options for selected portion of table. Select and
format different parts of the table, as needed.
Click OK. Find new style’s name in task pane.
Click it to apply it to table.

Table style, modify 79
Click in table. Choose Table, Table AutoFormat

to open Table AutoFormat dialog box. Choose
Modify to open Modify Style dialog box. Select
any portion of table and change its formatting.
Click OK. When Table AutoFormat dialog box

reappears, click Apply.
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Table, add caption to

Click in table’s first row. Choose Insert, Refer-
ence, Caption. In Caption dialog box, edit text
in Caption text box. Click OK.

Table, adjust height of 717
Select table. Choose Table, Table Properties,

Row tab. Deselect Specify Height check box.
Click OK. Drag table’s resize handle upward or
downward to adjust its height. Table’s rows will

adjust proportionately to table’s overall height.

Table, AutoFit to Contents

Select table. Choose Table, point to AutoFit, and
then choose AutoFit to Contents. Table’s column
widths are adjusted to best fit their contents.

Table, AutoFit to Window

Click in table. Choose Table, AutoFit, AutoFit to
Window. Table expands horizontally to fill page.

Table, AutoFormat

Click in table. Choose Table, Table AutoFormat.
Select All table styles from Category list. In
Table styles list, select style. Under Apply spe-
cial formats to, select check boxes for portions
of the table that should receive special formats
for selected style. Click Apply.

Table, calculate average values in row or column 7-22
Click in the table cell that will display the
result. Choose Table, Formula to open Formula
dialog box. Delete all text in Formula box
except the equals sign (=). Click Paste function
drop-down arrow and choose AVERAGE. In
the parentheses following the function’s name,
type a bookmark (such as ABOVE or LEFT),
the addresses of the individual cells to be aver-
aged (such as B3,C3,D3), or the cells’ range
(such as B3:D3). Select a format from the
Number format list. Click OK.

Table, calculate total values in row or column 7-23
Click in table cell that will display result.
Choose Table, Formula to open Formula dialog
box. Delete all text in Formula box except the
equals sign (=). Click Paste function drop-down
arrow and choose SUM. In parentheses follow-
ing the function’s name, type bookmark (such
as ABOVE or LEFT), addresses of individual
cells to be totaled (such as B3,C3,D3), or the
cells’ range (such as B3:D3). Select format from
Number format list. Click OK.
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Table, change all cell margins

Select table. Choose Table, Table Properties,
Table tab. Click Options button. Set left, right,

top, and bottom margins. Click OK twice.

Table, change single cell’s margins
Select cell. Choose Table, Table Properties, Cell
tab. Click Options button. Clear Same as the
whole table check box. Set left, right, top, and
bottom margins. Click OK twice.

Table, change vertical alignment in cells 17
Select table. Choose Table, Table Properties,

Cell tab. Under Vertical alignment, choose
alignment setting. Click OK.

Table, control page breaks in 7-1

Select table. Choose Table, Table Properties,
Row tab. Clear Allow row to break across
pages check box. Click OK.

Table, create from Excel worksheet

In Word document, place insertion point where
you want table to appear. Switch to Excel docu-
ment, select cells whose data will appear in
table, and click Copy button [E8]. Switch back to
Word document and click Paste button [B.

Table, define heading row 712
Select row or rows that will repeat at top of

each page where table appears. Choose Table,
Heading Rows Repeat.

Table, draw with gridlines 7-15

Display Drawing toolbar. Click Draw button.
Click Grid. In Drawing Grid dialog box, select
Snap objects to grid and Display gridlines

on screen check boxes. Click OK. Using
pointer, draw table on screen by dragging to
create cells.

Table, insert form fields for calculation in

| 413
Move to appropriate cell in table. Click Text
Form Field button [abl on Forms toolbar. Click
Form Field Options button [&. Under Type,
choose Number. In Default number text box,
key number 0. Click Calculate on exit check box
to select that option. Click OK.

Table, insert text above 7-5
If there is no blank paragraph mark above

table, click in table’s first cell. Choose Table,

Split Table. Click newly inserted paragraph

mark and type your text.
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Table, resize proportionately 714
Click in table. Rest mouse pointer over table
so table resize handle appears. Point to table
resize handle. When mouse pointer changes
to two-headed arrow, drag handle in desired

direction to resize table.

Table, sort on multiple columns 7-18
Click in table you want to sort. Choose Table,
Sort. In Sort dialog box, specify first column on
which to sort, specify type of sort, and select
Ascending or Descending. Specify second (and
third, if desired) column on which to sort, and

set its sorting options. Click OK.

Table, sort on one column At
Click in column on which you want to sort

table. Display Tables and Borders toolbar.

Click either Sort Ascending button |24 or Sort

Descending button [Z1].

Table, split 7-4
Click in row that will become first row of new
table. Choose Table, Split Table.

Table, turn off heading rows 7-3

Select table’s heading row or rows. Choose
Table, Heading Rows Repeat.

Table, use AutoSum in

Move to appropriate cell in table. Click Auto-
Sum button | £| on Tables and Borders toolbar.

Template, create new

If New Document task pane is not open, choose
File, New to open it. Under New from template,
click General Templates and the Templates
dialog box opens with Blank Document high-
lighted. Under Create New, choose Template (in
the lower-right corner). Blank Document might
change to gray. Click OK.

Template, save document as

Choose File, Save As. In File name box, key
template name. From Save as type list, choose
Document Template. Click Save.

Text box, change direction of text in

Click border of text box. Click Change Text
Direction button |llfij on Text Box toolbar.

Text box, delete
Click border of text box. Press [Delete] .
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Right-click border of text box, choose Format
Text Box, click tab, and choose options. Or
select text box and use buttons on Drawing
toolbar.

Text box, format

Text box, insert m

Click Text Box button |[£] on Drawing toolbar
and draw text box in drawing canvas. Or press
Esc] to delete drawing canvas and then draw

text box.

Text box, select
Click border of text box.

[ 119
Text box, size m

Click border of text box and drag a handle to
resize. To resize to exact measurement, double-

click border and use Size tab of Format Text
Text flow options, apply

Box dialog box.
N
Select text. Choose Format, Paragraph, Line
and Page Breaks tab. Choose Keep with next
to keep two paragraphs together, choose Keep
lines together to keep lines of a paragraph
together, or choose Page break before to start a

paragraph at a new page.

Text form field, insert ml
Position insertion point where you want field
to appear. Click Text Form Field button |abl| on
Forms toolbar.

Text wrapping, apply to objects

Click Text Wrapping button [ for object, if
available, and choose option. Or double-click
object, click Layout tab, click Advanced, click
Text Wrapping tab. Under Wrapping style,
choose option. Under Wrap text, choose option.
Click OK twice.

Toolbar, add buttons to 6-17

Right-click any toolbar and choose Customize.
Click Toolbars tab. Click New. Key toolbar
name. Click OK. Drag Customize dialog box
out of the way to see new toolbar. Click Com-
mands tab. In Categories list, select category
of buttons. In Commands list, locate button
you want and drag it onto new toolbar. Close
Customize dialog box.
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Toolbar, delete 6-17 Watermark, create from picture ml
Open Customize dialog box. Display Toolbars For clip already inserted, click Color button

tab. Select toolbar from list. Click Delete. Click on Picture toolbar, choose Washout, and send

OK when asked if you're sure you want to delete picture behind text. Or choose Format, Back-
toolbar. Close Customize dialog box. ground, Printed Watermark, Picture watermark,
Toolbar, remove buttons from 6-17 Select Picture; then navigate to folder/picture

Open Customize dialog box. Drag button file, click picture, click Ingert, and click OK.

off toolbar to remove it. Close Customize
dialog box. Watermark, create from text ml

m Choose Format, Background, Printed Water-
mark, Text watermark. Choose option from Text

Track changes, accept

Click revision and click Accept Change drop-down list or key text. Click OK.
button [¥#| on Reviewing toolbar to accept
change. Or right-click revision and choose Web page, add a frame m

Accept Insertion or Accept Deletion from

In Web page, choose Format, Frames, New
shortcut menu.

Frames Page. Frames toolbar opens. Word

Track changes, accept all m opens new document with the Web page con-
Choose Tools, Track Changes. Click Accept tent in it. Click New Frame button (Left, Right,
Change button down arrow [£]. Choose Accept Above, or Below). Add text, images, or buttons

All Changes in Document. in your new frame.

Track changes, enter revision marks m ' '

Turn on Track Changes mode: double-click Web page, create using Web Page Wizard m
“TRK” on status bar, or choose Tools, Track Choose File, New. Click General Templates, and
Changes, or click Track Changes button [&] on then click Web Pages tab. Select Web Page
Reviewing toolbar. Wizard and click OK. Click Next to display

m Title and Location dialog box. In Web site title
text box, key Web page title. Set Web site loca-
tion to your Lesson folder (use Browse button,

Track changes, move to next revision
Click Next button [¥] on Reviewing toolbar.

Track changes, reject m if needed). Click Next. In Navigation dialog
Click revision and then click Reject Change/ box, choose navigation type. Click Next. In
Delete Comment button |£# on Reviewing Add Pages dialog box, click Blank Page 2, if
toolbar. Or right-click revision and choose it is not highlighted, and then click Remove
Reject Insertion or Reject Deletion from Page, if you want to remove the second page.
shortcut menu. Click Next. In Organize Pages dialog box, click
Track changes, reject all m Next. In Visual Theme dialog box, click Browse

Themes. Click theme you want to apply and

Choose Tools, Track Ch . Click Reject
oose Tools, Track Changes. Click Rejec then click OK. Click Next. Click Finish.

Change/Delete Comment button down

arrow . Choose Reject All Changes in
Document. Web page, format m

m Use standard formatting commands to format

. Web page. Add a background, bulleted list,
Choose View, ﬂeadgr apd Footer to open and any type of formatting you wish. To add
Header pane. If unlinking footer, click Switch scrolling text, open Web Tools toolbar and click

Between Header and Footer b“tt‘)? ' Use Scrolling Text button . Key scrolling text in
Shoyv Next b}ltton to go to'sectlon you uv\éant text box. Change Background color of scrolling
unlinked. Click Same as Previous button |£] to text if you want. Click OK.

break link.

Unlink section headers/footers




